Website Design Guide
### Contents

**Website Design Introduction** ................................................................. 5  
Website Overview ....................................................................................... 5  
Website Accessibility .................................................................................. 7  

**Pages & Templates** .................................................................................. 8  
Buttons in Pages & Templates .................................................................... 8  
Pages ............................................................................................................ 10  
Templates ...................................................................................................... 17  

**Layouts** ................................................................................................... 24  
Create Layouts ............................................................................................. 24  

**Style Sheets** ............................................................................................ 31  
Create Style Sheets ...................................................................................... 31  

**Image Library** ........................................................................................ 39  
Upload Images ............................................................................................... 39  
Edit Image Properties ................................................................................... 41  
Profile Images ................................................................................................. 43  
Profile Image Configuration .......................................................................... 44  
Photo Albums on Your Website ...................................................................... 49  

**Friendly URLs** ......................................................................................... 52  

**Forms** ...................................................................................................... 55  
Online Forms: Process Overview ................................................................. 56  
Design Forms ................................................................................................. 57  
Sample Forms ................................................................................................. 67  
Manage Data from Online Forms ................................................................. 67  
Export or Print Form Data ............................................................................ 69  
Form Payments ............................................................................................... 69  
Properties of Form Elements ....................................................................... 70  
Step and Section Elements .......................................................................... 71  
Image Element ............................................................................................... 71  
Text Element ................................................................................................. 72
Text Field, Text Area, and Email Elements ................................................................. 73
Checkbox Element ............................................................................................................ 74
Radio Button List, Checkbox List, and Dropdown List Elements ................................... 75
File Attachment Element ................................................................................................. 77
Validators ......................................................................................................................... 78
Website Design Introduction

You create web pages in Site explorer. To modify web pages, you can design page layout, create and use templates, and add and remove part type information and images. Most likely, users who create web pages are site administrators with Supervisor rights. This section contains information about how to create and edit the parts for your web pages in Site explorer.

Website Overview

The diagram depicts how to use the program to construct a web page from start to finish. Stylesheets, Layouts, and templates sections are for Administrator use only. Most likely, you do not need to create layouts and templates for a new web page; you use existing ones. If you have edit rights, you can create and update web pages and part types. The Administrator must assign these security rights to user roles.

For information about security, see the Users & Security Guide.
Site explorer contains multiple sections. Each plays a major part when you construct and design a web page.

**Pages & templates** — You can store each web page and template individually in Pages & templates with quick access to each page. You can also create, edit, and delete pages for your website and view the URL path for each page. To create a web page, you must add content parts from Parts to your page in Pages & templates.

**Note:** Templates are the framework for your website and establish consistency throughout your site. Administrators can create, edit, and delete templates in Pages & templates. When you create web pages, you can start with an existing template.

**Image library** — Use Image library to add, delete, and approve images for your website. In addition, view a preview of an image to make sure it appears on the screen correctly. Images must be saved as a *.bmp, *.gif, *.jpg or *.jpeg file. An image does not appear on your website until you add it to a web page.

**Parts** — Use Parts to create, edit, and delete reusable content information, such as a user login and user profile form. A content part does not appear on your website until you add it to a web page. Add parts from Parts to your page in Pages & templates. You can also assign security rights to roles for each content part in Parts.

For more information about Parts, see the Parts Guide.
Note: With some parts and layouts, you use a powerful HTML editor to format and lay out several features, such as email, newsletters, and content on web pages. With the HTML editor, you can update content easily and safely while you maintain control over the website design and content.

**Layouts** — Administrators use *Layouts* to design and place panes on your web page. In *Pages & templates*, these panes contain parts and images. To customize layouts, insert rows, add bullets, and adjust font size and style.

**Style sheets** — Administrators use style sheets to create unique elements such as colors, font types and size, and spacing for your website. Style sheets, written in Cascading Style Sheet (CSS) format, are easier to use than other methods such as HTML. Unless you specify a custom style sheet, your website uses the program’s default style sheets. In *Style sheets*, you can create custom style sheets that override a default style.

**Files** - Use *Files* to add, delete, and approve files for your website. *Files* also provides you with access to all Documents part files in one location.

**Website Accessibility**

For web and accessibility standards, you can design a website that conforms to guidelines defined by the World Wide Web Consortium (W3C) and its Web Accessibility Initiative (WAI). The W3C created the WAI to explain how to provide web content to people with disabilities. The WAI guidelines are intended for use by all web content developers such as page authors and website designers, and for developers of authoring tools. A select number of parts meet strict WAI level AA compliance guidelines by way of automated validation, while others meet WAI level A compliance.

It is important to note that Blackbaud NetCommunity Spark itself is not inherently WAI compliant or non-compliant. The design decisions you make as you build the site will have the most significant impact on whether your Blackbaud NetCommunity Spark site is WAI compliant. In order to ensure that your website is WAI compliant, we recommend reviewing WAI standards and designing your site in accordance with the guidelines articulated here: [https://www.w3.org/WAI/guid-tech](https://www.w3.org/WAI/guid-tech).
Pages & Templates

Buttons in Pages & Templates ......................................................................................... 8
Pages ...................................................................................................................................... 10
Templates .............................................................................................................................. 17

In Pages & templates, you create, edit, and delete web pages and templates that contain reusable parts. To fit the needs of your website, you can customize pages and templates. When you create or edit a page on the page design screen, you can add or create parts in editable panes inherited from the template. You can edit and remove parts on the web page.

Think of Pages & templates as the shell for your website. The program stores pages and templates here for you to access each piece. Although you can manage parts in Parts, we recommend that you create and update parts in Pages & templates. This allows you to preview the page and see how parts fit together.

You can assign security rights to user roles for web pages and templates. You use security rights to protect web pages and templates that are secure, complicated in design, or appear repeatedly on your website.

When you host multiple sites, you can create pages and templates for individual sites. To do this, log in to the site and create the page or template. For more information, see the Administration Guide.

Buttons in Pages & Templates

In Pages & templates, the design screen allows you to design pages and templates. You use buttons to edit or create parts and perform other tasks.
For information about the buttons on the design screen in *Pages & templates*, expand an option below. For information about how to design pages or templates, see [Design a web page on page 13](#) and [Design a template on page 21](#).

**Template or Page part**

When you design a page and a part is on the template, the **Template part** button appears. Click the button to access options such as **Insert part**, **New part**, and **Edit Page Template**.

If a part is on the page, the **Page part** button appears. In addition to the **Template part** options, this button includes **Edit**, **Cut**, and **Paste** options.

**Pane**

The design screen contains **pane** buttons to add or create parts. Panes are content placeholders that default from the layout. Click the button to access options such as **Insert part**, **New part**, and **Show/Hide Part Markers**.

After you insert a part, the **Template pane** or **Page part** button replaces the **pane** button.
Template or Page part for part in approval process

If this button appears, the part is in the content approval workflow. When you click the button, the part status and a menu appear. The part status, such as “Draft,” appears at the top of the menu. The menu includes options such as Set Approval Status, Publish Now, Reject Changes, Insert part, and New part.

The menu items vary according to security rights and roles. If you cannot view a menu item, check with your system supervisor.

Note: Blackbaud NetCommunity Spark does not support workflows and approvals.

Edit part

The Edit part button appears for parts within a Targeted Content part. To edit a part, click the button. To edit the Targeted Content part, click the Template part or Page part button. In the menu, select Edit. For information about the Targeted Content part, see the Parts Guide.

Enable navigation

For menu parts, if you want to open the corresponding page from the page design screen, click Enable navigation.

Pages

To create a web page, you select a template and add parts to the page. The page design screen contains editable panes based on the template where you can add or create parts. You can also edit or remove parts. Although you can manage parts in Parts, we recommend that you create and update parts from the page in Pages & templates. This allows you to preview the page and see how parts fit together.

You can assign security rights to user roles for each web page. You use security rights to protect web pages that are secure, complicated in design, or appear repeatedly on your website. For more information about security, see the Users & Security Guide.

The following parts become incompatible if you include them on the same page:

- Membership Form and Membership Form
- Membership Form and Fundraiser
- Fundraiser and Fundraiser

When you create a page and include one of these parts, the second part is not available for the page. If an existing page includes both parts, a warning message informs you that the parts are incompatible.

Create a web page

Show Me: Watch how to create a page and define page properties.
Show Me: To create a web page:

1. From Site explorer, select Pages & templates. Pages & templates appears.
   - Note: You can also create a web page based on an existing web page by selecting a page in the grid and choosing Click here to copy this page.
   - The Copy page screen appears. The original page values default in the Page name, Browser title, and Page URL fields with "(Copy)" appended. You can keep or edit the information, and then select Save.
3. In the Page name field, enter a name to identify the web page in Pages & templates. The page name does not appear on your website.
4. The page name defaults in the Browser title field. You can leave the page name or enter a different name to appear on the web page title bar. When you edit page settings in Sites & settings, you select whether to display this browser title and whether to include your organization name and site name.
   For more information about web page titles in Sites & settings, see the Administration Guide.
5. In the Folder field, select a folder for the page. You can use folders to group related web pages. By default, the program stores pages in the root Website folder. You cannot edit this folder.
6. 1. In the Site to select template from field, select a site to narrow the list of templates you can use for the page. You can select a template from another site even though the page is for the site you are currently on. If you do not host multiple websites, your single site defaults in the field.
   2. For information about sites, see the Administration Guide.
7. In the Template field, select a template. For information about how to create a template, see
8. In the **Page URL** field, the program suggests a URL for the new page based on the page name or browser title you enter and the folder you select to store the page in. For example, if you enter "2014 Annual Fund" for the page name and select to store the page in the Donation folder, the program suggests to use the URL "Donation/2014-Annual-Fund". You can leave the suggested URL or enter your own unique URL for the page. If the URL exists for another page, the field displays a warning to indicate you cannot use it.
   - These page URLs enhance search engine optimization (SEO) for your website by including keywords in the URLs and links that search engines use to index content.
   - The program does not include the root Website folder in the URL. The full URL appears just below the **Page URL** field. You can select the full URL to copy it, but you cannot change it.

9. In the **Metadata description** field, enter a description to embed in the page’s HTML coding. When search engines include the page in search results, the description appears with a link to the page.

10. In the **Metadata keywords** field, enter keywords for search engines to include in online searches. For example, you can use keywords to describe pages that have little text or to include terms that are not on the page but are likely search criteria. Separate keywords with commas.
   - The metadata fields are each limited to 255 characters. In general, search engines do not examine more than 255 characters of metadata.
   - The page’s HTML coding also includes metadata for the last date the page was modified. This date reflects the most recent change to the page or to a part on the page. However, it does not include changes to parts stored within parts on the page. For example, a Targeted Content part can contain multiple parts to display content according to user roles. If a system supervisor modifies these parts but not the Targeted Content part itself, the change is not reflected in the metadata.

11. To apply metadata keywords from the template, select **Include keywords from Template**.
   - Each keyword appears only once in a web page’s META tag. If you enter duplicate keywords or inherit duplicate keywords from the template, they only appear once in the HTML coding.

12. To assign security rights for the page, select the **Targeting & security** tab. For each user role, you can manage rights to view, edit, delete, and change security for the page.
   For information about security and user roles, see the Users & Security Guide.

13. Select **Next**. The page design screen appears.
   For information about how to design a page, see Design a web page on page 13.

**Edit web page properties**

1. From **Site explorer**, click **Pages & templates**. **Pages & templates** appears.
   To view the properties for a web page, select it in the grid. Below the grid, select the Properties tab. This tab displays information such as whether the page uses Secure Sockets Layer authentication and the number of page hits.

2. To edit a page’s properties:
1. Select the and choose Click here to view/edit this page’s properties. The Page properties screen appears.

2. Make changes as necessary.
   - The options on the Properties tab and Targeting & Security tab are the same as on the New Page screen.
   - For a detailed explanation, see Create a web page on page 10.

3. Select Save. You return to Pages & templates.

**Design a web page**

To design a web page, you add parts to the page. The page design screen contains editable panes where you can add, edit, or remove parts. Although you can manage parts in Parts, we recommend that you create and update parts in Pages & templates. This allows you to preview the page and see how the parts fit together.

*Show Me:* Watch how to add content to a page.

1. From Site explorer, click Pages & templates. Pages & templates appears.
2. Select a page and click Click here to edit this page. The page design screen appears.

**Add parts to empty panes**

3. To add a part to an empty pane:
   1. Select the pane button.
      - If a part exists in the pane, click the Page part button.
   2. A menu appears.
      - If the Page part button displays an hourglass, the part is in the content approval workflow.
• For information about the menu items, see Buttons in Pages & Templates on page 8.

3. Depending on the template, the page design screen may contain multiple panes for parts.

4. A Template part button appears with parts from the template.

➤ Add pages to menus

**Tip:** To add the page to a menu:

1. To add the page to a menu, select **Add page to menu** on a menu part.

2. The Menu part opens and defaults to the Design tab.

3. In the box on the left, select where you want the page to appear in the menu.

4. To add the page to the location, select **Insert this page** and enter menu item properties for the page.
   
   For more information about menu item properties, see the *Parts Guide*.

5. The **Add page to menu** option appears for menu parts on a page and from a template.

When you add a page to a menu part for a template, it is important to remember the menu changes for all pages that use that template.

➤ Create New Parts

• To create a part:

1. Select **New part**.

2. The New Part screen appears.

3. To create a new Formatted Text and Images part, select **Add Formatted Text & Images**.
   
   For more information about this part, see the *Parts Guide*.

4. To move a part with a pane, select **Move up** or **Move down**.

➤ Add Existing Parts

• To add a part:

1. Select **Insert part**.

2. The Select a Part screen appears.

3. Search for parts by folder, part type, name, or site.

➤ Edit Parts

• To edit a part:

1. Select **Edit**.

2. The Edit Part screen appears.
3. When you copy a page and then edit a part that is shared across multiple pages or websites, a message appears to ask if you want to update the part for all pages and websites, or insert a new copy of the part on that page.

4. When you edit a shared part from the page design screen, you can choose create a new copy of the part at the top of the existing part to copy the part for that page.
   • The copied part replaces the previous part on the page so your changes do not affect other pages or websites that share the original part.

For information about parts, see the Parts Guide.

Remove Parts
- To remove a part:
  1. Select Cut.
  2. The program saves the part to the clipboard.
     • To place it in another pane, select Paste.
  3. You can cut and paste parts from one pane to another, but if your session times out, the program clears the clipboard. When you reopen the program, you can no longer paste the part.

Edit style sheets
- Administrator Step: To edit the style sheet, select Edit style sheet.

Warning: When you edit a style sheet, you change it for all layouts, templates, and web pages that use it.

Warning: For more information about style sheets, see Style Sheets on page 31.

Hide Page part buttons
- To hide Page part buttons on the page design screen, select Show/hide part markers.

Enable Menu links
- To enable links in a Menu part, select Enable navigation.
  • This allows you to click links in the menu and access the page design screen to those pages.

Preview pages
Note: To view how the page appears to different website users:
  1. Select a role in the View as field and select View.
  2. You can preview the page as visitors see it on desktop browsers or mobile devices.
  3. To display the page as it appeared on a particular date, enter the date in the on date field and
select View.

4. Administrator Step: To edit the page’s properties, click **Page properties**.

5. Administrator Step: To edit the template, click **Template designer**.
   - When you edit a template, you change it for all the web pages that use it.
   - To create a unique template for a web page, you can copy an existing template.

6. Administrator Step: To edit the page’s layout or style sheets, click **Edit layouts & CSS**.
   - You can access the layouts and style sheets for desktop browsers and for mobile devices. Style sheets are listed in the cascading hierarchy that you define in Style sheets.
   - To see and manage your style sheets, select **Manage style sheets**.

7. To delete the page, click **Delete**.
   - You can restore it from the Deleted folder on the Folders tab.

8. The program automatically saves your changes.

To return to **Pages & templates**, click **Return**.

**Upgrade a Blackbaud secure payment page**

When you edit page properties, the Blackbaud secure page preview tab appears if the page contains a part that uses the Blackbaud secure payment page.

To help you comply with the Payment Card Industry Data Security Standard (PCI DSS), the program uses the secure payment page to process biographical billing information and credit card payment information for the Event Registration and Payment 2.0 parts.

Users enter the information on the secure payment page that is hosted on a separate Blackbaud server from your website.

For more information, refer to **Secure Payment Page on page 1**.

For more information, refer to the **Parts Guide**.

The tab displays a preview of the secure payment page’s appearance with your organization’s content. You can use the horizontal bar to scroll and mimic page responsiveness for website users on various devices. To toggle the template examples between the desktop and mobile style sheet associated with the page, select the browser option in the **Preview with** field.

For more information about style sheets, refer to the **Website Design Guide**.
Templates

Templates are the framework for your website. You create and design templates to provide consistent website components from one web page to another. To create a web page that is different from the rest of your website, you most likely will create a special template. For example, your organization may want to add an online donor recognition page with a virtual wall similar to your newsletters. To create a page that is different from existing pages, you must start from the beginning with a new template. In Pages & templates, the design of the template becomes the main component for the donor recognition page. To save time and effort during the template design, you can add pieces from other areas of the program such as Layouts, Parts, and Image library.

These parts become incompatible if you include them on the same template.

- Membership Form and Membership Form
- Membership Form and Fundraiser
- Fundraiser and Fundraiser

When you create a template and include one of these parts, the second part is not available for the template. If an existing template includes both parts, a warning message informs you that the parts are incompatible.

**Warning:** We strongly recommend that you assign supervisor rights for this section to only a select group of users. General users should not access templates. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program should perform tasks in this section.

Create a template

After you create a template, you can use it for multiple pages.
1. To create a template:
2. From Site explorer, select Pages & templates.
3. Pages & templates appears.
4. Select New template.
5. The New Template screen appears.
   - To create a template based on an existing template, select a page in the Pages & templates grid and choose Click here to copy this template.
   - In the Copy template screen, enter a name in the New Template name field and select Save.
6. In the Template Name field, enter a name to identify the template in Pages & templates. This name is for internal use and does not appear on the website.
7. In the Folder field, select a folder for the template. You can use folders to group templates.
   - By default, the program stores templates in the root Website folder. You cannot edit this folder.
8. Under Select Layouts, select layouts for the template. You can select different layouts for desktop browsers and mobile devices.
9. In the Site to select layout from fields, select a site to narrow the list of layouts you can use for the template. You can select a layout from another site even though the template is for the site you are currently on.
If you do not host multiple websites, your single site defaults in the field.

For information about sites, see the Administration Guide.

9. In the **Layout** fields, select a layout for the template.
   - The layout is crucial to your website's appearance. It determines the design and placement of elements on templates. The layout includes where to place content, graphics, and navigation buttons.
   - For information about how to create layouts, see [Layouts on page 24](#).

10. In the **Metadata Description** field, enter a description to embed in the template's HTML coding. When a search engine includes a page with the template in search results, the description appears with the link to the page.

11. In the **Metadata Keywords** field, enter keywords for search engines to include in online searches, separating keywords with commas.
   - For example, you can use keywords to describe pages that have little text or to include terms that are not on the page but are likely search criteria.
   - Each keyword appears only once in a web page's META tag, so if a web page inherits a duplicate keyword from the template, it only appears once in the HTML coding.
   - The metadata fields only allow 255 characters. In general, search engines do not examine more than 255 characters of metadata.

12. The template's HTML coding also includes metadata for the last date the template was modified. This date reflects the most recent change to the template or to a part on the template. However, it does not include changes to parts that are stored within parts on the template.
   - For example, a Targeted Content part can contain multiple parts to display content based on user roles. If a supervisor modifies these parts but not the Targeted Content part itself, the changes are not reflected in the metadata.

13. To assign security rights for the template, select the Targeting & Security tab.
   - For each user role, you can manage rights to view, edit, delete, and change security for the template.
   - For information about security and user roles, see the Users & Security Guide.

14. Select **Next**.

15. The template design screen appears.

For information about how to design a template, see [Design a template on page 21](#).
Edit template properties

View Template Properties

1. To view template properties:
2. Select the template in the Pages & templates gallery and choose the Properties tab below the gallery.
3. This tab includes information such as whether the template uses Secure Sockets Layer authentication and the number of page hits.

Edit Template Properties

Warning: We strongly recommend that you limit supervisor rights for this section to a select group of users. General users should not access templates. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program perform tasks in this section.

4. To edit template properties:
1. From Site explorer, select Pages & templates.
2. Pages & templates appears.
3. Select the template and choose Click here to view/edit this template’s properties.
4. The Template properties screen appears.
5. Make changes as necessary. The options on the Properties tab and Targeting & Security tab are the same as on the New Template screen.
   - For a detailed explanation, see Create a template on page 17.
6. On the Usage tab, you can view the web pages that use the template.
7. Select Save.
8. You return to Pages & templates.

**Design a template**

Templates provide the framework for the pages on your website. Because of the time, research, and detail involved to design templates, we recommend that you base new pages on existing templates rather than creating new templates. However, you can edit a template to fit the needs of a web page, or you can copy a template to make adjustments as necessary.

**Warning:** We strongly recommend that you limit supervisor rights for this section to a select group of users. General users should not access templates. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program perform tasks in this section.

1. To get started:
   1. From Site explorer, select Pages & templates.
   2. Pages & templates appears.
   3. Select a template and choose Click here to edit this template.
   4. The template design screen appears.

**Add Parts to Panes**

2. Add parts to the editable panes that the template inherits from the layout.
3. To add a part to an empty pane:
   1. Select the pane button.
   2. If a part exists in the pane, click the Page part button.
   3. A menu appears.
   4. If the Page part button displays an hourglass, the part is in the content approval workflow.
      - For information about the menu items, see Buttons in Pages & Templates on page 8.
5. To add a part, select Insert part. The Select a Part screen appears.
   - You can search for parts by folder, part type, name, or site.
Edit Parts

- To edit a part:
  - Select Edit and the Edit Part screen appears.
  - For information about parts, see the Parts Guide.
- To move a part within a pane, select Move up or Move down.
- To enable links in a Menu part, click Enable navigation. This allows you to click links in the menu and access the page design screen to those pages.

Remove Parts

- To remove a part, select Cut. The program saves the part to the clipboard. To place it in another pane, select Paste.

**Warning:** You can cut and paste a part from one pane to another, but if your session times out, the program clears the clipboard. When you reopen the program, you can no longer paste the part.

  - *Administrator Step:* To edit the style sheet, select Edit style sheet.

Review Templates

**Note:** To view how the template appears to different website users, select a role in the View As field and choose View.

**Note:** You can preview the template as visitors see it on desktop browsers or mobile devices.

**Note:** To display the page as it appeared on a particular date, enter the date in the on date field and choose View.

Edit Templates & Style Sheets

4. To edit the template’s layout or style sheets:
   1. Select Edit layouts & CSS.
   2. You can access the layouts and style sheets for desktop browsers and mobile devices.
      - Style sheets are listed in the cascading hierarchy that you define in style sheets.
      - To see and manage your style sheets, select Manage style sheets.
   3. When you edit a layout, you change it for all the web pages that use it. To create a unique layout for a template, you can copy an existing layout.
      - For more information, see Layouts on page 24.
   4. When you edit a style sheet, you change it for all layouts, templates, and web pages that use it.
      - For more information about style sheets, see Style Sheets on page 31.
   5. To see your style sheets, click Merge style sheets.
• From this screen, you can also edit the template’s properties, copy the template into a new one, and delete the template.

6. To hide Page part buttons on the template design screen, select Show/hide part markers.
7. The program automatically saves your changes. To return to Pages & templates, click Return.

▷ Delete Templates
5. To delete the template, select Delete.
6. You can restore it from the Deleted folder on the Folders tab.
7. The program automatically saves your changes. To return to Pages & templates, select Return.
In Layouts, you design the overall appearance of the pages on your website. Layouts are a critical part of your website, and the design settings that you put in place play a crucial role in the success of each and every page on your website.

On your layouts, you include images, links, and other items that appear on web pages throughout your website. In combination with style sheets, layouts provide the basis of your website's design and allow you to create a consistent look and feel for your web pages.

In addition, you use layouts to define where you can place content on web pages and templates. You include content placeholder panes in the layouts, and after you associate the layout with web pages and templates, you can insert parts in the panes to display content on your website.

**Warning:** We strongly recommend that you limit full supervisor rights for Layouts to a select group of users. General users should not access layouts. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program perform tasks in Layouts.

**Create Layouts**

When you design layouts, you create the design settings that play a crucial role in the success of your entire website. Layouts determine the appearance of multiple pages on your site, and they must be in place before you can create individual web pages.

Before you create a layout, you must have at least one style sheet available. The style sheets you associate with a layout allows you to edit the appearance of elements such as fonts and colors. Style sheets also affect the appearance of the content on the web pages and templates that you associate with the layout. For information about style sheets, see [Style Sheets on page 31](#).

On your layouts, you include images, links, and other items to display throughout your site. These design elements provide the backdrop for all web pages and templates associated with a particular layout. In addition, you include content placeholder panes in layouts to define where to place content on templates and web pages. After you associate a page or template with a layout, you can insert parts in these panes and display content on your website.

For example, you can create a layout with your logo at the top, your mission statement at the bottom, background colors that match your branding, and content placeholder panes throughout. When you create a template based on the layout, the template inherits the logo, mission statement, and background colors, and you can insert parts in the panes. When you create pages based on such a template, the pages inherit the logo, mission statement, colors from the layout, as well as any content
from the template. In the remaining content placeholder panes, you can insert parts to display content that is particular to the web page.

**Warning:** We strongly recommend that you limit full supervisor rights for *Layouts* to a select group of users. General users should not access layouts. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program perform tasks in *Layouts*.

### Create a layout

If you host multiple sites, you can log in to a site to create site-specific layouts for that site. For more information, see the *Administration Guide*.

1. From Site explorer, click **Layouts**. *Layouts* appears.
2. Click **New layout**. The New Layout screen appears.

**Note:** You can also use an existing layout as the starting point for a new layout. Select a layout in the gallery and click **Click here to copy this layout**. After you save the layout with a new name, you can edit it as necessary.

3. Under **Layout properties**, enter a name and description for the layout, and select the DOCTYPE for the pages and templates that use this layout. The layout name is for internal use and does not appear on your website.
Note: We recommend selecting HTML 5, which is backwards compatible. If you prefer to keep HTML 4 as the DOCTYPE, HTML 5 elements still render correctly for modern browsers (for example, Internet Explorer 9 or higher).

4. Under **Style sheet**, select a site to narrow the list of style sheets you can use for the layout, and then select a style sheet for the layout. If you do not host multiple websites, your single website defaults in the first field. For information about style sheets, see Style Sheets on page 31.

5. Click **Next**. You return to **Layouts**. For information about how to design a layout, see Design a layout on page 28.

Edit layout properties

1. From **Site explorer**, click **Layouts**. **Layouts** appears.

   **Warning:** We strongly recommend that you limit full supervisor rights for **Layouts** to a select group of users. General users should not access layouts. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program perform tasks in **Layouts**.

2. Select a layout and click **Click here to view/edit this layout’s properties**. The Layout Properties screen appears.
3. Edit the layout name, description, DOCTYPE, and style sheet as necessary.

4. If you host multiple sites, the **Assign to site** field appears. You can move a layout from its current site to another site. If the layout is in use on a web page on the source site, it continues to appear on that site. However, the layout is now associated with the target site and its security.

5. Under **Usage**, the screen displays the templates and web pages that use the layout.

6. Click **Save**. You return to **Layouts**. For information about how to design a layout, see [Design a layout on page 28](#).

**Preview a layout**

With preview, you can test a layout before it is live on your website. The preview replaces a web page’s existing layout with the new layout, but it does not alter the actual web page.
**Tip:** Preview uses the names of content placeholder panes to determine where to display page content. For example, content in an existing layout's pane "1" appears in the new layout's pane "1." If content placeholder names do not match, then page content does not appear in the preview.

1. From Site explorer, click **Layouts**. *Layouts* appears.
2. Select a layout and click **Click here to preview**. The Preview Layout screen appears.
3. In the **Choose a page for a preview** field, select a page for the preview.
4. Click **Next**. The program creates a preview URL. It applies the new layout to the web page in a new instance of your web browser. The preview does not alter your live website.

**Note:** You can navigate in the preview URL to see the layout in place throughout your website. You can also share the preview URL with other users to allow them to preview the layout.

### Design a layout

1. From Site explorer, click **Layouts**. *Layouts* appears.

**Warning:** We strongly recommend that you limit full supervisor rights for *Layouts* to a select group of users. General users should not access layouts. Any change can affect multiple web pages. We recommend that only users knowledgeable in all areas of website design and the program perform tasks in *Layouts*.

2. Select a layout and click **Click here to edit this layout**. The Layout designer screen appears.
3. In the HTML editor content area, enter the content for the layout and format its appearance. The content appears on all pages that you associate with the layout. For example, you can include your organization’s mission statement and logo to display them throughout your website.

For information about the HTML editor, see the *Program Basics Guide*.

**Note:** When you update a layout, it is important to include similar characteristics from the rest of your website. This provides a uniform look for your website as users move from page to page. For example, include buttons, links, images, fonts, and colors that are consistent with the rest of your site. You can use Cascading Style Sheets (CSS) to make most of these customizations in *Style sheets*. For information about style sheets, see *Style Sheets on page 31*.

4. To add a content placeholder pane to the layout, click **Content placeholder** on the Insert tab in the toolbar.

5. On the screen that appears, enter a name and description to identify the pane.

**Tip:** We recommend that you use a standard naming convention for your content placeholder panes. This allows you to change the layout for a web page and still retain its content. For example, if you replace the layout for a page with a layout that uses the same pane names, the content in the original layout’s panes appear in the corresponding panes in the new layout. So
page content in the original pane “1” would appear in the new layout’s pane ”1.” If pane names do not match, then page content no longer appears on a web page if you replace its layout.

6. Click **Insert**. A yellow icon appears for the content placeholder pane.

   You use these panes to insert content on templates and pages. When you create templates and web pages, you select a layout, and its content placeholder panes determine where you can insert parts. For more information, see **Website Overview on page 5**.

7. To edit the style sheet for the layout, click **Edit style sheet**. The Edit style sheet screen appears. After you edit the style sheet, click **Apply**. The changes appear in your page design

   **Warning:** When you edit a style sheet, you change the style for any layouts, templates, or web pages that use it. If a layout uses the default style sheet, the **Edit style sheet** button does not appear because you cannot edit the default style sheet. For more information, see **Style Sheets on page 31**.

8. Click **Save**. You return to **Layouts**.
Style Sheets

Create Style Sheets

Style sheets create unique elements such as colors, font types and size, and spacing for your website. Style sheets, written in Cascading Style Sheets (CSS) format, are easier to use than other methods such as HTML. Unless you specify a custom style sheet, your website uses the default style sheets. You can create custom style sheets in Style sheets that override a default style. When you override elements in style sheets, we recommend you make changes only once to update the pages that use the style sheet. This saves time and helps eliminate mistakes when you update your website. You use style sheets when you create layouts in Layouts. In Layouts, you link a style sheet to the layout. For more information, see Create Layouts on page 24.

Create Style Sheets

When you design and customize your website, we recommend you test the rendering of your site in multiple browsers. For example, if your primary browser is Internet Explorer, also test your site with Mozilla Firefox. If your site renders differently, we recommend you modify your style sheets so your site has a similar look and feel in all browsers you test.

Warning: We strongly recommend your organization assigns full Administrator rights to only a select number of users for Style sheets. General users should not have access to style sheets. Any change can affect multiple web pages. We strongly recommend only users knowledgeable in all areas of website design and the program perform tasks in Style sheets.

Create a style sheet

1. From Site explorer, click Style sheets. Style sheets appears.

Note: You can also use an existing style sheet as the starting point for a new style sheet. Select a style sheet on the All style sheets tab and click Click here to copy this style sheet. After you save the style sheet with a new name, you can edit it as necessary.
3. In the **Style sheet name** field, enter a name for your style sheet. This name helps program users quickly identify the file in *Style sheets*. The name is for internal use and does not appear on your website.

4. In the **Description** field, enter any additional information about the style sheet.

5. When you host multiple sites, the **Assign to site** field appears so you can move a style sheet from its current site to another site. If the style sheet is in use on a web page on the source site, it continues to appear on that site. However, the style sheet is now associated with the target site and its security.

6. Under **Style sheet options**, select whether to apply the style sheet to a specific target.
   - To make the style sheet available for all templates, select **None**.
   - To apply the style sheet to a specific media type such as portrait screen dimensions for smartphones, select **Media**. In the textbox, enter the media query for the target.
   - For help to create a media query, please contact the appropriate software vendor or IT professional for assistance since this is beyond Blackbaud’s **scope of support**.
   - To apply the style sheet to a specific browser, select **Browser**. For example, an older browser may not handle your preferred styles, so you may need to create a style sheet to handle these exceptions to the browser.

7. To assign security rights for users and roles for the style sheet, select the Targeting & Security tab.
**Note:** You can apply the style sheet to the Desktop browsers or Mobile devices tabs in Style sheets. In addition, you can also apply the style sheet directly to a layout. For information about layouts, see [Layouts on page 24](#).

8. Click **Next**. The Edit style sheet screen appears. For information about how to design a style sheet design, see [Design a style sheet on page 34](#).

**Edit a style sheet’s properties**

1. From **Site explorer**, click **Style sheets**. **Style sheets** appears.

**Warning:** We strongly recommend that your limit rights for this section to a select group of users. General users should not access style sheets. Any change can affect multiple web pages. We strongly recommend only users knowledgeable in all areas of website design and the program perform tasks in **Style sheets**.

2. Select a style sheet and click **Click here to view/edit this style sheet’s properties**. The Style sheet Properties screen appears.

3. Make changes as necessary. For information about the options on this screen, see [Create a style sheet on page 31](#).

**Note:** When you host multiple sites, the **Assign to site** field appears so you can move a style sheet from its current site to another site. If the style sheet is in use on a web page on the source site, it
continues to appear on that site. However, the style sheet is now associated with the target site and its security.

4. To view the web pages that use the style sheet, select the Usage tab.
5. Click Save. You return to Style sheets.

**Preview a style sheet**

With preview, you can test a style sheet before it is live on your website. The preview applies the new style sheet to a web page but does not alter that page on your live site.

1. From Site explorer, click Style sheets. Style sheets appears.
2. On the All style sheets tab, select a style sheet and click Click here to preview. The Preview style sheet screen appears.

3. In the Choose a page for a preview field, select a page for the preview.
4. In the Select delivery channel field, select whether to preview the style sheet in a desktop browser or a mobile device.
5. Under Configure style sheet delivery order, select where to apply the style sheet. You can replace an existing style sheet or add the style sheet to your list of applied style sheets.
6. Click Next. The program creates a preview URL. It applies the new style sheet to the web page in a new instance of your web browser. The preview does not alter your live website.

**Note:** You can navigate in the preview URL to see the style sheet in place throughout your website. You can also share the preview URL with other users to allow them to preview the style sheet.

**Design a style sheet**

1. From Site explorer, click Style sheets. Style sheets appears.
**Warning:** When you design and customize your website, we recommend you test the rendering of your site in multiple browsers. For example, if your primary browser is Internet Explorer, we recommend you also test your site with Mozilla Firefox. If your site renders differently, we recommend you modify your style sheets so your site has a similar look and feel in all browsers you test.

2. Select a style sheet and click **Click here to edit this style sheet** under **Action**. The Style sheet text editor screen appears.

If you create a style sheet, first save the style sheet properties. For information, see Create a style sheet on page 31.
On this screen, you can edit properties through CSS. For example, you can edit the web page’s fonts, colors, backgrounds, and other properties. You can also insert HTML tags and apply styles to the tags.

3. To load the CSS selectors that allow you to edit the appearance of the parts that appear on your web pages, click **Insert CSS selectors**. The Insert CSS Selectors screen appears. You can access this screen multiple times to add multiple selectors.
4. In the **Insert selectors for** field, select the CSS selectors to include in the style sheet editor. To include the default style settings along with the names, select **Include defaults**.

5. Click **Insert**. You return to the style sheet editor, and the selectors appear in a new section within the editor. Edit the styles as necessary.

**Note:** To identify css classes on parts, we recommend you use a third-party tool such as *Firebug*.

6. After you edit the style sheet, click **Save** to return to the page designer. You can also click **Apply** to keep the style sheet editor open while you access web pages to view your changes.

7. Click **Save**. You return to *Style sheets*.

### Apply a style sheet

You can apply style sheets to desktop browsers, mobile devices, or both. Your existing style sheets appear on the All style sheets tab in numerical order. The program gives priority to style sheets that are higher in the list, and uses others when there are exceptions, such as when a website visitor is using an older browser. You may apply style sheets to desktop browsers and mobile devices and adjust the hierarchy as needed.

1. From *Site explorer*, click **Style sheets**. The *Style sheets* screen appears.

   ![Style sheets screen](image)

   You use Cascading Style Sheets (CSS) to edit the appearance of your website. Style sheets manage the design and layout of elements on your web pages and allow you to edit fonts, colors, and other properties. You create two distinct sets of style sheets: one to target desktop browsers and one to target mobile devices. Within each set, you can include multiple style sheets to target different scenarios such as specific browsers or smartphones.

2. To apply a style sheet to desktop browsers or mobile devices, select the Desktop browsers or Mobile devices tab. These tabs display their sets of style sheets and the order they are applied.
3. Click **Insert a style sheet**. The Insert style sheet window appears.

4. Select a style sheet. If you host multiple sites, select the site for the style sheet.
5. To rearrange the order of the style sheet, click the dotted buttons and drag and drop it.
6. Click **Save**.

**Note:** You also apply style sheets directly to layouts. When you create a layout, you select a style sheet for desktop browsers and for mobile devices. These style sheets are represented on the Desktop browsers and Mobile devices tabs in Style sheets in the Layout style sheets entry. For information about layouts, see [Layouts on page 24](#).
Image Library

**Upload Images** ................................................................. 39
**Edit Image Properties** .................................................................. 41
**Profile Images** ........................................................................ 43
Profile Image Configuration ................................................................. 44
**Photo Albums on Your Website** ......................................................... 49

In *Image library*, you can upload and store images to display on your website. After you upload images, you can use them repeatedly on your website. For example, you can upload an image of volunteers at work on your latest project and display it on a welcome page, a volunteers page, and a recent events page.

**Upload Images**

In *Image library*, you can upload images for your website and store them in folders. On the Folders tab, a root *Images* folder appears. You cannot edit or delete this folder, but you can click *Create a new folder* to add subfolders as necessary. You can also create subfolders within subfolders to organize your images, and you can move, rename, and delete folders as necessary.

After you upload images, you can display them throughout the website.

You can also allow website users to upload images.

*Note:* On the Settings tab in *Sites & settings*, you can require approval for the images that users upload. Under *User Image Options*, select *Require approval for all images uploaded by users*. When you select this checkbox, you must approve images before users can post them on your website. You can also limit the number of images users can upload, set a maximum file size, and select a default folder. For information, see the Administration Guide.

**Add images to Image library**

When you host multiple sites, you can add images for individual sites. To do this, log in to the site and add the image. For more information, see the Administration Guide.

2. Click *Add images*. The Add images screen appears.
3. Click **Add images**. A select files screen appears.

4. Select images from your hard drive or computer network and click **Open**. Thumbnails for the images appear under **Select images for upload**.

   **Tip:** Images must be *.bmp*, *.gif*, *.ico*, *.jpeg*, *.jpg*, or *.png* files. In addition, each file must meet the size limit for images. The default is set to 4 megabytes, but you can further restrict the maximum size in *Sites & settings*. The system administrator can also adjust the limit in the `web.config` file. For example, to increase the size to 8192, add `<location path="FileUpload.ashx"><system.web><httpRuntime maxRequestLength="8192"/></system.web></location>` to the configuration node of `web.config`.

5. To add more images, click **Add images** again. You can upload images from multiple locations. If you add an image by mistake, you click **Delete** on the thumbnail to remove it.

6. In the **Select folder** field, select a folder to store the images.

7. To approve the images for your website, select **Approve all images** under **Image options**.

   **Note:** If you select **Require approval for all images uploaded by users** on the Settings tab in *Sites & settings*, you must approve images that website users upload before they can post them on your website. If users post images that are not approved, they can see their images, but all other users see “Photo Not Available” graphics.

8. Click **Save & continue**. Additional options appear for the images.
9. In the **URL path** field, edit the end of the URL for the web page that stores the image. To improve rankings in Google image search results, image URLs should be as discrete and descriptive as possible. By default, the URL includes the image’s folder, name, and extension after your domain.

   - If you edit the image name, both the URL and the image name are updated.
   - If you edit the folder, only the URL is updated. The folder where you store the image remains the same.
   - You cannot edit the file extension.

10. In the **Alt text** field, enter text to appear in place of an image if it cannot display for some reason.

11. To associate tags with images, click **Edit Tags** or **Add tags to all**. Tags are keywords or phrases that identify an image’s content, and you can use them to search for images on the Search tab in *Image library*. On the Add selected tags screen, you can create tags or use existing tags. For more information about tags, see the *Parts Guide*.

12. Click **Save**. You return to *Image library*.

---

**Edit Image Properties**

After you upload images to *Image library*, you can edit them as necessary. You can replace images, edit names, URLs, and alt text, enter a photographer and date, and change the approval status. You can also edit targeting and security preferences and image tags.

Remember that if you include an image on multiple web pages, changes in *Image library* affect all instances.
Edit image properties

1. From Site explorer, click Image library. Image library appears.
2. Select an image in the gallery and click Edit. The Image properties screen appears.

**Note:** To search for images, use the Search tab. You can search by name, tag, image ID, image type, approval status, image owner, and site.

A thumbnail of the image appears on the Properties tab along with the dates when it was uploaded and last modified, the user who uploaded it, and the folder where it is stored. To access the user record of the website user who uploaded the image, click the user name. The User editor page in Users & security appears.

3. In the Name field, edit the name of the image. The name is for internal use and does not appear on your website.
4. In the URL path field, edit the end of the URL for the web page that stores the image. To improve rankings in Google image search results, image URLs should be as discrete and descriptive as possible. By default, the URL includes the image’s folder, name and extension. You can edit the folder and name in the URL, but this does not affect the image’s name or the folder where it is stored. You cannot edit the file extension.
5. In the Alt text field, edit the text that appears in place of the image if it cannot display for some reason.
6. In the Photographer and Date fields, enter the creator of the image and when it was created.
7. To approve the image for your website, select **Approve**.

**Note:** If you select **Require approval for all images uploaded by users** on the Settings tab in *Sites & settings*, you must approve images that website users upload before they can post them on your website. If users post images that are not approved, they can see their images, but all other users see "Photo Not Available" graphics.

8. To replace the image, click **Browse** beside the **Choose a different image** field. A choose file screen appears. Select an image on your hard drive or computer network.

**Tip:** Images must be *.bmp, *.gif, *.ico, *.jpeg, *.jpg, or *.png files. In addition, each file must meet the size limit for images. The web.config file limits images to 4 megabytes, but administrators can further restrict the maximum size on the Settings tab in *Sites & settings*.

9. To enter security settings, select the Targeting & security tab. For information about security settings, see the *Parts Guide*.

10. On the Tags tab, enter keywords or phrases to identify the image. The Tags tab for images is the same as for parts, but tags for images are not included in the results for the Suggested Content or Tag Display parts. For information about tags, see the *Parts Guide*.

**Note:** You can use an image's tags as search criteria on the Search tab in *Image library*. The tags are not included as hyperlinks on Tag Display parts.

11. Click **Save**. You return to *Image library*.

### Profile Images

All profile images upload to *Image library* and you can easily find them by using the Search tab. On this tab, in the **Image owner** field, you can search by the image owner's first name or last name. In the **Type of image** field, you can also search by "Profile."
You can also easily find profile images by selecting to upload them to the same folder in *Image library*. To do this, select a folder in the **Default profile image folder** field on the user image option site setting in *Sites & settings*. For more information, see the *Administration Guide*.

### Profile Image Configuration

To configure your website to include profile images, you must use the Profile Form and Profile Display parts. Website users upload images on the Profile Form part and the images display on the Profile Display part.

To include profile images on a Profile Form part, select the Profile Image section on the Individual tab. When you select to include the **Profile image** field, you provide the ability for website users to easily upload profile images.
When you select the checkbox in the **Include** column for the **Profile image** row, website users can add, edit, and remove profile images. To display custom text on pages beside the images, enter it in the **Alternate caption** field. The other checkboxes in the grid are disabled because they are not supported by the Profile Image section.

When a profile image displays on a profile web page, a square thumbnail of the user's image appears. The user can change or remove the image by clicking the links below it.
**Note:** When a website user has an existing profile image and uploads a new one on the profile page, the new profile image overwrites the previous image. This occurs on your website and in *Image library*.

To select the portion of it that appears as the profile, the user clicks the thumbnail image. On the screen that appears, the user drags the box to highlight the portion of the image to display and a thumbnail example appears on the right.
Before a user uploads a profile image, a default silhouette image appears as the profile. A link to add an image appears below the silhouette.
For more information about the Profile Form part, see the Parts Guide.

The Profile Display part includes a Profile image merge field in the HTML editor and height and width fields for you to configure maximum profile image sizes.

In the Max height/width for full-size image field, you enter the maximum display height and width for full-size profile images that display when users click thumbnails on the web page. In the Max height/width for thumbnails field, you enter the maximum height and width for profile image thumbnails on the web page.

The HTML editor includes the Profile image merge field on the Individual tab. To display the image a user uploads on the Profile Form part, include this merge field in the design box.
When you do this, the image appears on the read-only profile display web page for other website users to view. The square cropped image that a user selects on the Profile Form part displays as the profile image thumbnail. When website users click the thumbnail, the full-size image displays. For more information about the Profile Display part, see the Parts Guide.

Photo Albums on Your Website

Depending on user roles for your website, users may be able to post photos on some pages of your website. In areas where users can post photos, they use albums to manage photos and to select them for your website. The areas where users can manage photos include personal pages, the user networking site, user photos forms, and slideshows.

On personal pages, user photos forms, and slideshows, users can only upload photos to their photo albums and select images to display on the website.
**Note:** When you select **Enable Photos** for a User Networking Manager part, security options appear when a member creates an album. The member can make the photos viewable by everyone, friends only, or just the user (private). Album security applies to all areas where the photos are used in the website, including slideshows, personal pages, fundraiser personal pages, and profile displays.

On the user networking site, users can also create and delete albums, designate default albums, and select whether to allow other website users to view images in the albums. In addition, they can enter captions and other data for their images, copy or move images to other albums, select images as album covers and profile pictures, and delete images in their albums.
Friendly URLs

With friendly URLs, you can allow website users to access web pages with multiple URLs. For example, if your standard donation page is www.example.org/donate, you can create the friendly URL www.example.org/disasterrelief to direct users to that page in response to a natural disaster. Web browsers display friendly URLs just like the actual URLs.

Website users can also create friendly URLs. For example, if you support user networking on your website, a website user can add a profile page for the account and create a URL that is easy to remember, type, and verbalize to other users.

You can also create friendly URLs to link to another website. For example, you can create a friendly URL to link to an elected official’s website. When you create a friendly URL, we recommend you keep it short, simple, and easy for users to remember and verbally communicate.

Friendly URLs are an extension of your website’s domain. For example, a friendly URL to a web page about your organization’s annual walkathon could be “www.example.org/walkathon.” The domain name entered in the Site URL field on the Settings tab in Sites & settings determines the domain that appears in friendly URLs. For more information, see the Administration Guide.

Create a friendly URL

You can define a URL for any page on your website. You can also create URLs for pages in Pages & templates. Website users create URLs for personal pages for the Chapter Manager, Fundraiser, Personal Page Manager, or User Networking Manager parts.

Blackbaud NetCommunity Spark does not support the Chapter Manager, Fundraiser, Personal Page Manager, or User Networking Manager parts.

1. From Site explorer, click Friendly URLs. Friendly URLs appears.
2. Click New URL. The New URL screen appears.
3. Under **Friendly URL**, the domain entered in the **Site URL** field on the Settings tab in *Sites & settings* appears. In the field, enter the remainder of the URL for the friendly URL. For example, for a webpage about your organization’s annual walkathon, enter “walkathon.”

When you create friendly URLs, you can define the site architecture. For example, you can create a friendly URL of “www.example.org/walkathon” for a webpage with general information about your walkathon and “www.example.org/walkathon/donate” or “www.example.org/walkathon/donate.html” for the Donation Form associated with the event.

**Note:** Friendly URLs combine the domain name from the **Site URL** field in *Sites & settings* with the friendly URL information that you enter here. To change the domain portion of the URL, edit the URL in the **Site URL** field. For more information, see the *Administration Guide*.

4. To verify the friendly URL is available, click **Check Availability** next to the field. If the link is available, a success message appears.

If the URL is not available, adjust the link so it is unique.

5. Under **Target**, select the webpage for the friendly URL.
   - To search for the webpage, select **Site page** and browse to the page to associate with the link.
   - To enter the target URL for the webpage, select **Enter URL**. A field appears for you to enter the full URL.

**Tip:** If you are creating a friendly URL to link to an external website, select **Enter URL** and enter the external target URL in the field that appears.

6. Click **Save**. You return to **Friendly URLs**. In the grid, the new friendly URL appears.

### Edit a friendly URL

After you create a friendly URL, you can edit it as necessary. For example, you can correct typographical errors or associate the friendly URL with a different webpage.

1. From **Site explorer**, click **Friendly URLs**. **Friendly URLs** appears.
2. In the grid, find the friendly URL to edit and, in the Action column, click Edit. The friendly URL appears.

3. Edit the URL or web page associated with the link. For information about how to create a friendly URL, see Create a friendly URL on page 52.

**Note:** Friendly URLs combine the domain name from the Site URL field in Sites & settings with the friendly URL information that you enter here. To change the domain portion of the URL, edit the URL in the Site URL field. For more information, see the Administration Guide.

4. Click Save. You return to Friendly URLs.

**Delete a friendly URL**

You can delete friendly URLs from your website. For example, you can delete a friendly URL to remove a link for a web page that no longer exists.

1. From Site explorer, click Friendly URLs. Friendly URLs appears.
2. In the grid, find the friendly URL to delete.
3. In the Action column, click Delete. A confirmation message appears.
4. To delete the friendly URL, click OK. You return to Friendly URLs.
With Forms, you can create and manage online forms to collect information from website users. When you create forms, you use the Form Designer to create distinct steps and sections, insert instructional text and images, and insert fields to collect data from website users. The available field types include text fields, text areas, radio button lists, checkboxes, checkbox lists, dropdown lists, and a special email field that sends confirmation email messages to users who enter email addresses. These fields on the Common form type do not map to a database outside the program.

After you design a form, you use a Form Display part to create a landing page on the website. In Parts, you create a Form Display part and select the forms to include on the web page. On the website, users view the available forms, and they can click links to start, resume, delete, or print the forms.

**Warning:** To avoid security issues, do not use an iFrame from a third party website to direct users to this part on a web page. We recommend you design the page to include the same look and feel as your third party site so that users seamlessly transition to the page.

After you place forms on your website, you manage them in Forms. With the Form Designer, you can adjust the forms as necessary, and on the Data tab, you can view summary information about the forms.
and manage the data that website users submit. After users start form, you can use the Data tab to create PDFs with their data and delete form entries.

Online Forms: Process Overview

To create online forms and place them on your website, you must perform several steps in different areas of the program. For Common forms, the fields do not map to another database and the data that website users submit remains in the program.

Step 1
To allow users to create and manage online forms, you must provide security rights. To do this, you add the desired form-related rights to a task group. In Security Assignments, you then associate the task group with a role or an individual user. In the task group, you can provide users with full supervisor rights in Forms, rights to create forms but not edit or delete other users’ forms, view-only rights, or limited view-only rights for the form data that website users submit. For more information about security rights, see the Users & Security Guide.

Step 2
To create an online form, go to Forms and click New form. If you do not want to create a form from scratch, you can copy an existing form, create a form based on a sample in the Samples tab, or import an XML form. When you create the form, enter a name and select a form type to determine the available elements. The Common form type is available to all users and includes presentation elements and field elements that are available on all forms. The data you collect with Common forms does not map to another database.

Tip: When you host multiple sites, you can create forms for individual sites. To do this, log in to the site and create the form. For more information, see the Administration Guide.

Step 3
After you create a form, use the Form Designer’s Form builder tab to select the elements to include. To place elements on the form, select them under Available elements and drag and drop them to Selected elements. To edit properties for an element, place the cursor over the element and click Edit. With presentation elements, you can organize the form into steps and sections and add images and instructional text. Each form must include at least one step and one section. With field elements, you can place fields on the form to collect data. Common fields available on all forms include text fields, text areas, radio button lists, checkboxes, checkbox lists, dropdown lists, and a special email field that sends confirmation email messages to the email addresses that users enter.

Step 4
After you design the form on the Form builder tab, use the Form Designer’s other tabs to enter settings for the form. For information about the Form Designer, see Design Forms on page 57.

• On the Language tab, you can rename labels, headings, and other text for the form.
• On the Properties tab, you can change the form name and description. You can also suspend the form to allow website users to view their statuses but not start or submit forms.
• On the Targeting & security tab, you set the view rights to target the form to specific users.
• On the Login tab, select whether to require users to log in to access the form. You can also select whether to allow users to save and delete forms, and whether to create sign-up transactions in The Raiser's Edge for users who register for your site through the form.

• On the Payment tab, select whether to charge a fee when users submit the form.

• On the Submit settings tab, select whether to use the default confirmation screen when users submit forms or to design your own. Click Acknowledgement email to design the email message to send to users to confirm receipt of their form data.

Tip: In the form, the email address field is used to send the acknowledgement only if the user is not logged in. If the user is logged in, the acknowledgment email is sent to the email address associated with the login profile account.

Step 5
After you complete the form, you can place it on your website. To do this, you create a Form Display part in Parts and select the forms to include on the part. When you place the part on a web page, it acts as a landing page for users to access your online forms. On this page, a list of available forms appears, and after website users start forms, they can view the statuses and resume, delete, and print forms. On the Form Display part, you also enter login settings for users who access the page. For more information about the Form Display part, see the Parts Guide.

Step 6
After you place the Form Display part on the website, you return to Forms to manage forms. On the Data tab, you can view summary information about forms and manage the data that website users submit. On the Summary tab, the grid displays the number of forms started and completed for each form on the website. On the Detail tab, you can edit the data that website users enter on the forms. For more information about the Data tab, see Manage Data from Online Forms on page 67.

Design Forms
When you create online forms for your website, you use the Form Designer to include presentation elements and field elements. Presentation elements include steps, sections, images, and text. Forms are organized into steps and sections, and each form requires at least one step and section before you can add other elements. Field elements include text fields, text areas, radio button lists, checkboxes, checkbox lists, dropdown lists, and a special email field that sends confirmation email messages to the email addresses that users enter. These fields do not map to a database outside of the program. When you add multiple steps to a form, website users page through the form from one step to the next. If you charge a fee for users to submit the form, the payment information appears as an additional step.

After you complete a form, you use a Form Display part to place it on the website. On the web page with the part, website users can access all forms that you include on the part. From the web page, users can start forms, view their statuses, and resume, delete, and print forms.

For more information about the Form Display part, see the Parts Guide.

After you place the Form Display part on the website, you return to Forms to manage your forms. You can use the Form Designer to adjust the forms as necessary, and on the Data tab, you can view summary information about the forms and manage the data that website users submit. On this tab, you
can view overall statistics for each form and access the data that website users enter on the forms. You can also create PDFs with user data.

For more information about the Data tab, see Manage Data from Online Forms on page 67.

Create a form

1. From Site explorer, click Forms. Forms appears.
2. Click New form. The Form Designer appears.

If you do not want to create a form from scratch, you can copy a form or use a sample as a starting point.

- To copy a form, locate it in the Forms gallery and click Click here to copy this form. On the Copy Form screen, enter a name, select a folder, and click Next. The Form Designer appears, and you can edit the form as necessary.

- To copy a sample form, locate it on the Samples tab and click Click here to copy this sample. On the screen that appears, enter a name, select a folder, and click Next. The Form Designer appears, and you can edit the form as necessary. For information about samples, see Sample Forms on page 67.

- If you previously exported a form or sample in Blackbaud NetCommunity Spark, you can import the XML to create a copy of the form. To create the XML, you click sClick here to export this form or Click here to export this sample in the Forms gallery. To import the XML, you click Import form. On the Import Form screen, enter a name, select a folder, and paste the XML in the Form XML field. Click Next. The Form Designer appears, and you can edit the form as necessary.

Warning: You must copy and paste the XML from Notepad or another text editor. If you copy the XML directly from an XML editor or web browser, the Form Designer cannot create the form.
3. In the **Form type** field, select the form type. The form type determines the elements that are available for the form.
   - The Common form type only includes presentation elements and field elements that are available on all forms. Fields on a Common form do not map to another database.

4. In the **Form name** and **Form description** fields, enter a name and description for the form.

5. In the **Folder** field, select a folder to store the form. By default, the program uses the **Forms** root folder.

6. To prevent website users to start or submit the form, select **Suspend form**. This allows website users to view the statuses of their forms but not start forms or submit data. You can use this checkbox to enforce submission deadlines and still allow users to monitor their statuses online.

7. To design the form, click **Next**. The Form builder tab appears.
8. Under Available elements, the Form Designer displays the Common presentation elements and field elements that are available for all forms. To design the form, click and drag elements from Available elements to Selected elements. Under Selected elements, click and drag items to arrange the order for the website.

- Under Presentation elements, select items to organize the form. With steps, you create distinct portions of the form for users to page through. With sections, you group elements within each step. Each form requires at least one step, and each step requires at least one section because you cannot place other elements directly on steps. You can also add images and text as necessary.

- Under Field elements, select fields to collect data from website users. The Common field elements include the text field, text area, radio button list, checkbox, checkbox list, dropdown list, and a special email field that sends confirmation email messages to the email addresses that users enter. These fields do not map to a database outside of the program.

Note: To edit element properties such as labels, style sheets, and validators, place the cursor over an element in Selected elements and click Edit. An element properties screen appears. For information about properties of presentation elements and field elements, see Properties of Form Elements on page 70.

9. To rename the labels, headings, and other text that appears on the form, select the Language tab. For information about the Language tab, see the Website Design Guide.

10. To assign website security rights for users and roles, select the Targeting & Security tab. For information about the Targeting & Security tab, see the Website Design Guide.

11. To select login settings for the form, go to the Login tab.
12. To require website users to log in to access the form, select **Require login**. Additional login options appear.

- To allow website users to save their data on a form and return to it later, select **Allow user to save form**.
- To allow website users to delete a form and not submit it, select **Allow user to delete a form in progress**.
- To create constituent records in The Raiser's Edge for any users who register for your website through this form, select **Create Raiser’s Edge sign-up transactions**. You enter user login settings for the form on the Form Display part.

**Note:** For Common forms, **Create Raiser’s Edge sign-up transactions** is always selected when you require users to log in to access the form.

- To restrict users to submit a form only one time when they are logged in to your site, select **Allow only one form submission**.

13. To charge a fee when users submit the form, select the Payment tab and select **Charge fee with form**. Additional payment options appear.
14. Under Fee amounts, to add a fee amount, click **Add form fee**. The Fee amounts screen appears.
   a. Enter a name for the form fee.
   b. Enter the dollar amount for the form fee.
   c. In the **Criteria** field, select if the form fee applies to everyone or based on how a website user answers a field on the form.
   d. If you select Based on fields in the form, click **Add a new rule**. The New Rule screen appears.
   e. Select the step, section, field, and response, that if they choose on the form, the fee is added to the total form fee amount. For example, if a website user answers yes to participation in a club activity, you can charge a conditional fee on only club participants.
   f. Click **Save**. You return to the Fee amounts screen.
   g. Click **Save** again. You return to the Form Designer screen. Add as many separate form fees as you need.

15. Under Payment setup, select to use a Payment 2.0 part or to proceed directly to payment with your merchant account.

16. If you select to use a payment part, select the payment page and then write an acknowledgement message.
**Note:** If you select to use the payment part, you first need to set up your payment and merchant information in the Payment 2.0 part before you select it in the form.

17. If you select to use your merchant account, in the **Merchant account** field, select a merchant account such as your organization’s IATS account to process credit card transactions received through the form.
   
a. The system supervisor sets up merchant accounts in *Administration*. For more information, see the *Administration Guide*.

b. To display CAPTCHA text for users to enter before they proceed with the payment, select **Display reCAPTCHA**.

c. CAPTCHA is an automated public turing test to tell computers and humans apart to help prevent automated abuse of your website. You enable reCAPTCHA in *Administration*. For more information, see the *Administration Guide*.

18. Select the payment methods available to users. Credit cards are allowed by default.
   
   • To allow users to pay at a later time, select **Bill me later**.
   
   • To allow users to waive the fee, select **Allow users to waive the fee** and enter a waiver code in the field that appears.

19. To edit settings for when users submit the form, select the **Submit settings** tab.

   ![Checklist setting on form submission](image)
   
   **Checklist setting on form submission**
   Select the checklist item to mark complete when you receive the form.

   ![Confirmation screen](image)
   
   **Confirmation screen**
   Specify whether to use the default acknowledgement page or a custom one.
   - Use default confirmation screen
   - Use custom confirmation screen

20. Under **Confirmation screen**, select whether to use the default screen or create a custom screen.
   
   • To use the default, select **Use default confirmation screen**.
   
   • To design the confirmation screen, select **Use custom confirmation screen**. The HTML editor appears. The program’s default confirmation screen appears in the HTML editor for you to customize according to your needs.

   Edit the content for the confirmation screen. To format the appearance and layout, use the HTML editor toolbar. To include personalized information, use merge fields. For more information, see the *Program Basics Guide*.

   **Warning:** If you customize the confirmation screen and then select **Use default confirmation screen**, your changes to the confirmation screen remain. To remove changes, select **Use custom confirmation screen** and click **Restore default content**.
21. Under **Email alert**, select **Send an email alert when a user submits a form** to send an email to staff members when a website user submits a form.

![Email alert screen](image)

22. Under **Recipients**, to send the alert to individual users and users in a role, click **Add users and roles**. The Select users and roles screen appears.

![Select users and roles screen](image)

a. In the **Filter** field, enter the first letter of the user or role to include.
**Note:** The **Available** box displays 30 users and roles in alphabetical order. Use the **Filter** field to find additional users and roles that do not appear in the box.

b. Locate the user or role, and click **Add**. The user appears in the **Selected** box.

   To select multiple users or roles, press **SHIFT** while you select the multiple users, and then click **Add all**. The users appear in the **Selected** box.

c. Click **OK**. You return to the Submit settings tab. The users and roles appear in the **Users and roles** box.

23. To send the notification to a staff member who does not have a Blackbaud NetCommunity Spark account, enter an email address under **Email addresses**.

**Note:** You can select to send the notification to individual users and users in roles instead of, or in addition to, individuals who do not have a Blackbaud NetCommunity Spark account. When you enter multiple email addresses, separate them by a comma or semicolon.

24. Enter a subject in the **Subject** field and an email address in the **From** field for the email alert.

25. To display form data in the body of the email alert, select **Include form data in the email alert**. By default, the email links to a PDF version of the form, and when you select this option, the email also includes form data.

26. To create an acknowledgement email for website users who submit forms, click **Acknowledgement email**. The Acknowledgement Email screen appears.
27. Enter a name for the acknowledgment, a subject, a return address, and a name for the From field of the email message.

**Tip:** In the form, the email address field is used to send the acknowledgement only if the user is not logged in. If the user is logged in, the acknowledgment email is sent to the email address associated with the login profile account.

28. In the box, edit the content of the acknowledgment. To format the appearance and layout, use the HTML editor toolbar. For information about how to design an email acknowledgment, see the Email Guide.

29. Click Save to save your progress and continue to set up the form. You can also click Save and Close to return to Forms.

To post the form on your website, place it on a Form Display part. For information about the part, see the Parts Guide.

After you place the form on the website, you can view summary information about the form and manage the data that website users submit on the Data tab in Forms. For information about the Data tab, see Manage Data from Online Forms on page 67.
Sample Forms

In *Forms*, the Samples tab provides sample forms to use as a starting point for new forms. You cannot edit the samples or place them directly on your website through a Form Display part. However, they are useful to save time when you create forms. You can copy a sample form that is similar to the form you want and edit it as necessary.

**Copy a sample form to design a new form**

1. From *Site explorer*, click *Forms*. *Forms* appears.
2. Select the Samples tab. The gallery displays the available samples.

<table>
<thead>
<tr>
<th>Action</th>
<th>Form</th>
<th>Description</th>
<th>Form type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contact Form - Sample</td>
<td>Complete</td>
<td>Common</td>
</tr>
<tr>
<td></td>
<td>K-12 Form - Sample</td>
<td></td>
<td>Online Admissions</td>
</tr>
</tbody>
</table>

3. To create a form based on a sample, select it and click **Click here to copy this sample**. The Copy Form screen appears.
4. Enter a name, select a folder for the new form, and click **Next**. The Form Designer appears, and you can edit the form as necessary. For information about how to design a form, see [Design Forms](#) on page 57.

**Note:** You can also create an XML version of a sample form and use the XML to create a form. To generate the XML, select the sample and click **Click here to export this sample**. To create a form based on the XML, click **Import form**. On the screen that appears, enter a name, select a folder, and paste the XML from Notepad or another text editor into the **Form XML** field. Click **Next**. On the Form Designer, you can edit the new form as necessary.

5. Click **Save**. You return to *Forms*.

To post the form on your website, place it on a Form Display part. For information about the part, see *Parts Guide*.

After you place the form on the website, you can view summary information about the form and manage the data that website users submit on the Data tab. For information about the Data tab, see *Manage Data from Online Forms* on page 67.

Manage Data from Online Forms

After you place forms on your website, you can go to *Forms* to manage the data that website users submit. On the Data tab, you can view summary information about the forms, and after users start
forms, you can manage their data.

On the Summary tab, the grid displays the number of forms started and completed for each form on the website. On the Detail tab, you can edit the data that website users enter on the forms. You can also delete, export, and print entries. On the Export & Print tab, you can filter your forms to export a group of form data to a .csv file or print the data. On the Payments tab, you can review and export the payment information for each submitted form.

Manage data that website users submit in online forms

1. From Site explorer, click Forms. Forms appears.
2. To view information about the forms on your website and manage the data that website users enter on the forms, select the Data tab.
3. On the Detail tab, entries appear for the data that website users enter. To filter the entries, enter your search criteria and click Search. Entries that match your criteria appear.
   - To search a particular site, enter the site in the Forms created on field.
   - To search for data from a particular form, select it in the Form field.
   - To search for data from a particular form type, select it in the Type field.
   - To filter data according to whether users started or completed the form, use the Status field.
   - To filter data according to when users completed the form, enter a start date in the Date completed field and an end date in the To field.

   Note: The Date completed and To fields are disabled when you select “All” or “Started” in the Status field because you cannot search for forms that were started during a period of time.

   - To filter data according to whether you created PDFs, use the Print status field.
4. On the Summary tab, statistics appear for all forms on the website. The list includes the number of times website users started and submitted each form on your website.
5. On the Export & Print tab, you select the criteria to filter forms for print or export. For more information, see Export or Print Form Data on page 69.
6. On the Payments tab, you can review the payment status for a form and export the payment information to a .csv file. For more information, see Form Payments on page 69.
7. To manage the data that website users submit, select the Detail tab. Entries that match the search criteria on the Data tab appear.
   - To view a form’s data, click a user name under Name. An HTML version of the form appears in a separate window. You can use this HTML as a preview before you perform any actions.
   - To create a PDF with user data, select the checkboxes for the data to include and click Print. The PDF appears in a separate window. You can save or print the PDF for your records.
   - To create a comma-separated-values file with user data, select the checkboxes for the data to include and click Export. The program creates a .csv file that you can edit in Microsoft Excel.

   Note: You cannot create a .csv file with data from multiple forms. All the entries you select must include data from the same form.

   - To delete entries, select the checkboxes and click Delete. For example, you may want to delete entries after you process the data.
8. As website users create and submit forms, the program updates the Data tab. To manage the data from your online forms, you will need to monitor the Data tab.

Export or Print Form Data

On the Export & Print tab, you select criteria to determine which forms you want to print or export from Forms. If you select to export form data, you can save or open a .CSV file. If you select to print form data, a new window opens and your data appears as a .PDF file. You can choose to print the data or save the Adobe Acrobat file. To print the data, from the browser window, click File, Print. Select the name of the printer and your print options, then click OK.

To filter the forms for export or print, select your filter criteria:
- To print or export data from one site location in your organization, click the binoculars to search for and select the site in the Forms created on field.
- To print or export data from a particular form, select it in the Form field.
- To print or export data from a particular form type, select it in the Type field.
- To print or export data with a particular form status, select it in the Status field.
- To print or export data from a particular date or date range, select it in the Form completed field.
- To print or export data based on the print status, select the status in the Print status field.

Form Payments

When you manage the data that website users submit in online forms, you can review the payment information on the Payments tab. For each form, you can review the submitted data, a summary of the payment information, and export the payment data to a .CSV file.
• In the **Form Data** grid, for each submitted form, you can review the amount, card type, cardholder name, last 4 digits of the social security, the payment status, payment date, the reference number, and form name.

• To review the submitted form’s payment data, in the **Name** column, click the student’s name. A new window opens with the submitted form information.

• To export form payment data, select the payments individually or select the checkbox in the top row to select all on the page. A link appears at the top of the page if you want to select all payments on all pages. Click **Export**. A file download screen appears. You can open or save the .CSV file.

<table>
<thead>
<tr>
<th>Name</th>
<th>Amount</th>
<th>Card type</th>
<th>Cardholder name</th>
<th>Last 4 digits</th>
<th>Status</th>
<th>Reviewed</th>
<th>Payment date</th>
<th>Reference n</th>
</tr>
</thead>
<tbody>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>1/14/2012</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>12/21/2011</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>12/11/2011</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>2/16/2012</td>
<td></td>
</tr>
<tr>
<td>John Paul</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>12/21/2011</td>
<td></td>
</tr>
<tr>
<td>John Paul</td>
<td>$10,160.00</td>
<td>Visa</td>
<td>Ron Paul</td>
<td>1111</td>
<td>Completed</td>
<td></td>
<td>2/16/2012</td>
<td>9096C3</td>
</tr>
<tr>
<td>Card Paul</td>
<td>$10,605.80</td>
<td>Visa</td>
<td>Ron Paul</td>
<td>1111</td>
<td>Completed</td>
<td></td>
<td>2/17/2012</td>
<td>250060</td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>1/18/2012</td>
<td></td>
</tr>
<tr>
<td>John Paul</td>
<td>$10,124.99</td>
<td>Visa</td>
<td>Ron Paul</td>
<td>1111</td>
<td>Completed</td>
<td></td>
<td>2/17/2012</td>
<td>250060</td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$10.00</td>
<td></td>
<td></td>
<td></td>
<td>Bill me later</td>
<td></td>
<td>12/4/2011</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>1/13/2011</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>12/21/2011</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>12/21/2011</td>
<td></td>
</tr>
<tr>
<td>John Paul</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>1/17/2012</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>1/11/2012</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>1/10/2012</td>
<td></td>
</tr>
<tr>
<td>Josh Smith</td>
<td>$0.00</td>
<td></td>
<td></td>
<td></td>
<td>Waived</td>
<td></td>
<td>12/22/2011</td>
<td></td>
</tr>
<tr>
<td>John Paul</td>
<td>$10,759.99</td>
<td>Visa</td>
<td>Ron Paul</td>
<td>1111</td>
<td>Completed</td>
<td></td>
<td>2/19/2012</td>
<td>ENFRR</td>
</tr>
</tbody>
</table>

99 payments meet selected criteria

Total amount: $87,947.95

---

**Properties of Form Elements**

After you place elements on a form in the Form Designer, you can edit the properties for the elements. To design the form, drag and drop items from **Available elements** to **Selected elements**. To edit the properties for an element, place the cursor over the element in **Selected elements** and click **Edit**. An
element properties screen appears. After you edit the properties, click **Save**. The tables in this section describe the properties for the Common presentation elements and field elements that are available for all forms.

### Step and Section Elements

You use the step and section elements to organize the form. With steps, you create distinct portions on your forms for users to page through. With sections, you group elements within steps. Each form requires at least one step, and each step requires at least one section because you cannot place other elements directly on steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Enter a label for the step or section.</td>
</tr>
<tr>
<td><strong>Hide label</strong></td>
<td>If the label is for internal purposes and should not appear on the website, select <strong>Hide label</strong>.</td>
</tr>
<tr>
<td><strong>Custom CSS class</strong></td>
<td>To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class. For information about style sheets, see the Website Design Guide.</td>
</tr>
</tbody>
</table>

### Image Element

You use the image element to place images from *Image Library* on the form.
### Option | Function
---|---
**Alternative text** | Enter text to appear in place of the image if the image is unavailable for any reason.

**Custom CSS class** | To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class.

For information about style sheets, see the *Website Design Guide*.

**Insert image, Remove image** | To select an image from *Image Library*, click **Insert image**. The Select Image From Image Library screen appears. The image you select appears under **Preview**. To remove it, click **Remove image**.

For information about *Image Library*, see the *Website Design Guide*.

---

### Text Element

You use the text element to insert instructional text or additional information on the form. The text is not associated with field elements. You can use it to guide users through the form.
**Option**  **Function**

**Text**  Enter text to appear on the form. The text element displays up to 500 characters and is not associated with a field element. You can use the text to provide step- or section-level instructions.

**Custom CSS class**  To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class. For information about style sheets, see the *Website Design Guide*.

---

**Text Field, Text Area, and Email Elements**

With the text field, text area, and email elements, you can place fields on the form for users to enter data. The text field and email elements are standard fields, while the text area element includes additional space for longer responses.

**Warning:** The email element is a special field that sends confirmation messages to the email addresses that users enter. To collect email addresses but not send confirmation messages, use the text field element.
<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Function</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a label for the field.</td>
</tr>
<tr>
<td>Hide label</td>
<td>If the label is for internal purposes and should not appear on the website, select Hide label.</td>
</tr>
<tr>
<td>Required</td>
<td>To require users to enter a value in the field before they can submit the form, select Required.</td>
</tr>
<tr>
<td>Required message</td>
<td>If a field is required, enter text to appear beside it when users attempt to submit the form without values in the field.</td>
</tr>
<tr>
<td>Hidden</td>
<td>If a field is for internal purposes and should not appear on the website, select Hidden. You must enter a value in the Default value field.</td>
</tr>
<tr>
<td>Inline help</td>
<td>Enter instructional text or additional information about the field. A link beside the field allows users to access the text.</td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class. For information about style sheets, see the Website Design Guide.</td>
</tr>
<tr>
<td>Validator</td>
<td>To restrict entries to certain characters or formats, select a validator. For information about the validators, see Validators on page 78.</td>
</tr>
<tr>
<td>Validation warning</td>
<td>If you select a validator, a default error message appears in this field. The message appears beside the field when users attempt to submit the form and the field entry does not meet the validator's requirements. You can edit the message as necessary.</td>
</tr>
<tr>
<td>Character limit</td>
<td>Enter the maximum number of characters for the field.</td>
</tr>
<tr>
<td>Default value</td>
<td>Enter a default value to appear in the field when users start the form.</td>
</tr>
<tr>
<td>Include in export</td>
<td>To include the field when you export data that users submit on the form, select Include in export. To exclude it when you export, clear the checkbox.</td>
</tr>
</tbody>
</table>

**Checkbox Element**

With the checkbox element, you can place a standalone checkbox on the form and select whether to select it for users by default.
<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enter a label for the checkbox.</td>
</tr>
<tr>
<td>Hide label</td>
<td>This option is disabled for the checkbox element.</td>
</tr>
<tr>
<td>Required</td>
<td>To require users to select the checkbox before they can submit the form, select <strong>Required</strong>.</td>
</tr>
<tr>
<td>Required message</td>
<td>If the checkbox is required, enter text to appear beside it when users attempt to submit the form without selecting it.</td>
</tr>
<tr>
<td>Hidden</td>
<td>If the checkbox is for internal purposes and should not appear on the website, select <strong>Hidden</strong>. You must select a value in the <strong>Default value</strong> field.</td>
</tr>
<tr>
<td>Inline help</td>
<td>Enter instructional text or additional information about the checkbox. A link beside the checkbox allows users to access the text.</td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class.</td>
</tr>
<tr>
<td></td>
<td>For information about style sheets, see the <em>Website Design Guide</em>.</td>
</tr>
<tr>
<td>Default value</td>
<td>Select “Yes” to select the checkbox by default or “No” to clear it.</td>
</tr>
<tr>
<td>Include in export</td>
<td>To include the checkbox when you export data that users submit on the form, select <strong>Include in export</strong>. To exclude it when you export, clear the checkbox.</td>
</tr>
</tbody>
</table>

**Radio Button List, Checkbox List, and Dropdown List Elements**

With the radio button list, checkbox list, and dropdown list elements, you can place fields on the form for users to select responses. You can enter the options for users to select from, or you can import
code table values from The Raiser's Edge.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Enter a label for the list.</td>
</tr>
<tr>
<td><strong>Hide label</strong></td>
<td>If the label is for internal purposes and should not appear on the website, select <strong>Hide label</strong>.</td>
</tr>
<tr>
<td><strong>Required</strong></td>
<td>To require users to select a value in the list before they can submit the form, select <strong>Required</strong>.</td>
</tr>
<tr>
<td><strong>Required message</strong></td>
<td>If the list is required, enter text to appear beside it when users attempt to submit the form without selecting a value in the list.</td>
</tr>
<tr>
<td><strong>Hidden</strong></td>
<td>If the list is for internal purposes and should not appear on the website, select <strong>Hidden</strong>. You must select a value in the <strong>Default value</strong> field.</td>
</tr>
<tr>
<td><strong>Inline help</strong></td>
<td>Enter instructional text or additional information about the list. A link beside the list allows users to access the text.</td>
</tr>
<tr>
<td><strong>Custom CSS class</strong></td>
<td>To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class.</td>
</tr>
<tr>
<td></td>
<td>For information about style sheets, see the Website Design Guide.</td>
</tr>
<tr>
<td>Option</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List values (enter values on separate lines)</td>
<td>In the dropdown list, select whether to create a list or import entries from a code table. To create a list, enter values on separate lines. To import code table entries, select the code table. You can edit the code table entries you import, but your changes do not affect the source code table. <strong>Warning:</strong> For checkbox lists, entries cannot include nonaphanumeric characters such as “&lt;,” “&gt;,” and “&amp;.” If you import a code table entry or enter a list item with such characters, no label appears on the form for that entry’s checkbox.</td>
</tr>
<tr>
<td>List default value</td>
<td>Enter a value to select by default in this list when users start the form.</td>
</tr>
<tr>
<td>Allow other</td>
<td>To allow users to enter values not in the list, select <strong>Allow other.</strong> When users select “Other,” a field appears on the form for these values.</td>
</tr>
<tr>
<td>Other field character limit</td>
<td>If you allow users to enter their own values, enter the maximum number of characters for the field.</td>
</tr>
<tr>
<td>Include in export</td>
<td>To include the list when you export data that users submit on the form, select <strong>Include in export.</strong> To exclude it when you export, clear the checkbox.</td>
</tr>
</tbody>
</table>

**File Attachment Element**

With the file attachment element, you can place a file attachment upload field on the form for users to upload documents to the form. For each file attachment element, you choose which Documents part to use for file attachment settings. Uploaded documents appear in *Forms* on the Data tab.
<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label</strong></td>
<td>Enter a label for the field.</td>
</tr>
<tr>
<td><strong>Hide label</strong></td>
<td>If the label is for internal purposes and should not appear on the website, select <strong>Hide label</strong>.</td>
</tr>
<tr>
<td><strong>Required</strong></td>
<td>To require users to select a value in the field before they can submit the form, select <strong>Required</strong>.</td>
</tr>
<tr>
<td><strong>Required message</strong></td>
<td>If the field is required, enter text to appear beside it when users attempt to submit the form without selecting a value in the field.</td>
</tr>
<tr>
<td><strong>Inline help</strong></td>
<td>Enter instructional text or additional information about the field. A link beside the field allows users to access the text.</td>
</tr>
<tr>
<td><strong>Custom CSS class</strong></td>
<td>To override the default Cascading Style Sheet (CSS) format of the page where the form appears, enter a custom CSS class. For information about style sheets, see the Website Design Guide.</td>
</tr>
<tr>
<td><strong>Select document part</strong></td>
<td>To upload files, the file attachment element uses the Document part to determine how files upload. Search for and select a document part to use. You can set up Document parts for each file attachment element used on a form, or create one Document part for all your file attachment needs. For information about the Document part, see the Parts Guide.</td>
</tr>
<tr>
<td><strong>Max file size</strong></td>
<td>This field displays the maximum file size allowed for document uploads. To edit the maximum file size, you need to edit the setting on the Document part.</td>
</tr>
<tr>
<td><strong>Allowed file types</strong></td>
<td>This field displays the MIME file types allowed for document uploads. To edit the MIME file types, you need to edit the settings on the Document part.</td>
</tr>
<tr>
<td><strong>Default file name</strong></td>
<td>Enter a default name for file uploads. If you do not enter a default file name, the file name as uploaded by the user defaults.</td>
</tr>
<tr>
<td><strong>Prefix form name</strong></td>
<td>To prefix your file name with the name of the form, select the checkbox. When a user uploads a file, the name will be &lt;form name&gt; - &lt;default file name&gt;</td>
</tr>
</tbody>
</table>

## Validators

After you add text field, text area, and email elements to forms, you can edit the properties to include validators. Several standard validators are available to ensure that user responses meet your criteria. The following table describes the restrictions that the standard validators enforce, as well as the default error messages that appear when users attempt to save data that does not meet the validator criteria.

<table>
<thead>
<tr>
<th>Validator</th>
<th>Allows</th>
<th>Default Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>Upper and lower case letters.</td>
<td>Please enter letters only.</td>
</tr>
<tr>
<td><strong>Validator</strong></td>
<td><strong>Allows</strong></td>
<td><strong>Default Error Message</strong></td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alphanumeric with spaces</td>
<td>Upper and lower case letters, numbers, and spaces.</td>
<td>Please enter letters, numbers, and spaces only.</td>
</tr>
<tr>
<td>Alphanumeric without spaces</td>
<td>Upper and lower case letters and numbers.</td>
<td>Please enter letters and numbers only.</td>
</tr>
<tr>
<td>Email</td>
<td>Email addresses with the format youraddress@yourdomain.</td>
<td>Please enter a valid email address with the format youraddress@yourdomain.</td>
</tr>
<tr>
<td>Numeric</td>
<td>Numbers (just a string of digits).</td>
<td>Please enter numbers only.</td>
</tr>
<tr>
<td>Numeric with decimals</td>
<td>Numbers (just a string of digits) and a decimal.</td>
<td>Please enter numbers and a decimal only.</td>
</tr>
<tr>
<td>Social Security number</td>
<td>Numbers and hyphens with the format ###-###-####.</td>
<td>Please enter a valid Social Security number with the format ###-###-####.</td>
</tr>
<tr>
<td>U.S. date</td>
<td>Legitimate date with the MM/DD/YYYY format. Months can take one or two digits, from 1 to 12 or 01 to 12. Days can take one or two digits, from 1 to 31 or 01 to 31. The validator recognizes the number of days in a given month and also takes leap years into account.</td>
<td>Please enter a date with the format MM/DD/YYYY.</td>
</tr>
<tr>
<td>U.S. phone</td>
<td>U.S. phone number with area code. The validator requires 10 digits. It allows hyphens or periods to separate the area code and first three digits of the phone number, and it allows parentheses around the area code.</td>
<td>Please enter a 10-digit phone number. You can use hyphens or periods to separate numerals, and you can put the area code in parentheses.</td>
</tr>
<tr>
<td>Zip code</td>
<td>5-digit Zip code or 9-digit Zip code with a hyphen after the first 5 digits.</td>
<td>Please enter a 5-digit Zip code or a 9-digit Zip code with a hyphen after the first 5 digits.</td>
</tr>
</tbody>
</table>